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Delorme Map ‘n’ Go 5.0
by John McMillan

Rochester Computer Society, Inc.

I
acquired version 5 of Delorme's AAA Map ‘n’ Go as a door prize from the Rochester

Computer Society. According to the box, it included the latest 1999 travel research

to assist in trip planning. Much of that may be out of date but most of the road and

town data could still be accurate. 

Minimum system requirements were listed as Windows 95/98, NT 4.0 or later; on

a 486DX/66 with 8 MB or RAM; 14 MB of available hard drive space; CD Reader; 256

color monitor with super VGA graphics; and a mouse. If used with one of the GPS,

voice navigation units listed, a 100 MHz chip was required and 16 MB of RAM; a sound

card with speakers; and a Windows compatible color or black and white printer were

recommended for a more satisfactory experience. Most current computers far exceed

these requirements.

I expected to find a users manual in the sealed box with the shrink wrapped CD.

The picture inside the jewel box turned out to be a 4.75 inch square, 15 page booklet

that described system requirements and repeated some of the outer box commentary.

It contained instructions for installing Map 'N' Go, or for running it from the CD. There

were also seven pages devoted to how to use the program; trouble shooting hints; and

technical support instructions; plus 3 pages of license agreement in 4 point type. Like

most software licenses, it didn't guarantee anything and all damages would be my

fault. 

I still chose to install it In the programs folder on my lap top for portability. This

went very easily with most instructions displayed on the monitor. Once installed,

checking properties for the hard disk showed that the new folder occupied 44 MB of

storage, not the 14 MB stated on the box. There were four sub folders; Photos, Tours,

Tutorials and Utilities including Adobe Acrobat to facilitate reading/printing the169

page PDF users manual. Over 70 pages are devoted to Standard Industrial Classifica-

tions for the phone search function.

I regretted not requesting an icon on the desktop since there were 4 executable

modules in the main folder. Clicking “Mng5.exe” seemed like the most logical choice.

It opened a small window with what appeared to be Delorme's logo. The cursor

changed to an hourglass but nothing else happened over the course of 3 or 4 minutes.

The CD was still in the drive so I used Windows Explorer to check the contents and

tried, unsuccessfully, to open AAA Map ‘n’ Go TestDrive.exe. I E-mailed questions to

a techie who sent back several extracts found on the web but none that said it would

not work. I googled “does AAA Map-n-Go 5.0 work with Windows XP.” Several

responses reported limited or no success so I installed it on a desktop running Windows

98. Again the installation went easily, though this time I asked for a desktop icon.

Clicking the icon opened the DeLorme logo which was replaced shortly by a window

with a title bar “Welcome to AAA Map ‘n’ Go 5.0“ plus an exit X in the upper right

corner but none of the customary menus or tool bars. The rest of the Welcome window

simulated a view from a cars front seat. 
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 The clipboard behind the left sun visor was a button that opened “Kids Travel

Activities,” A map protruding from the right sun visor is a button to open the main

window. A scenic view of trees, water and a distant city plus several highways had bill

board like signs which were really buttons to Explore AAA; Plan a Trip, Find a Place;

and Show Me. The radar detector and camera sitting on the dashboard were buttons

for GPS and slide show functions. An ignition switch lets you suppress the welcome

screen at startup, if desired and the glove box was an exit switch. 

I clicked the dashboard dial labeled Test Drive and a 2nd colorful window titled

AAA Map ‘n’ Go Test Drive appeared with choices for tutorials about. 

C Planning a Trip

C Locating Places

C Exploring AAA Information

C Editing Your User Profile

C Attaching AAA Points of Interest

C Printing Options.

I perused Planning a Trip and returned to the Welcome window to begin.

Clicking the map folder behind the right visor or the Plan a Trip billboard opens the

main window but Plan a Trip overlays a small instruction window. The main window

Menu Bar lists File; Edit; Find; View; Plan trip; Fun; GPS; Online; and Help. 

The View Menu controls the composition of the main window. The 1st 3 items in

View Menu identify key stroke shortcuts for magnification changes. There are also tool

icons for changing magnification. As the map is magnified, a smaller area is visible but

with increased detail. 4, the lowest magnification I could find had a scale of 500 miles.

Sixteen was the highest magnification with a scale of 1/10th of a mile.

 Check marks in the View Menu identify active items. Clicking a checked item

clears the check mark and associated display. Check Map Toolbar to see icons as a row

above the Trip Tool Bar or check Toolbox to see them in a window to the right with an

added compass rose for easier navigating around the main map. If neither is checked,

there won't be any tool icons.

 Checking Legend opens a scrollable window that defines symbols on the large map.

Checking Overview will replace the Legend window (if necessary) with a small window

showing the relationship of the visible portion of the larger map. 

 Checking AAA Points of Interest in the View Menu adds data to the map based on

the User Profile in Checking AAA Points of Interest in the Plan Trip menu. Any

combination of Lodgings, Restaurants, Campgrounds, Attractions, or AAA Offices can

be selected as well as the minimum magnification at which they will be seen. Tabs

open a dialogue box to identify factors like cost or type that further refine the chosen

categories.

Checking the Status Bar in View Menu displays descriptions that vary from the

functions of an icon under the cursor; to latitude and longitude of the cursors map

position; or the name of the street under the cursor, in highly magnified urban areas.

Further to the right is the magnification and associated scale of the main map. 

 I found the Classic Interface with separate Toolbox and Legend windows plus the

Trip Toolbar and status Bars to be easiest to use.
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Typing in start and end points in the Trip Menu will place the corresponding

colored circle at their respective places on the main map. Clicking the Go icon will

calculate the quickest route and connect the colored circles with a purple hatched line,

It also overlays the left side of the map with a route list that showed the Road

C Leg (length)

C Time

C Distance (cumulative)

C Direction

C Near

C Exit

Unchecking Route on Map in the View Menu, widens the map but in my opinion

removes helpful information. Positioning the cursor over the lists right edge makes it

a double headed arrow which can be dragged left to remove some or all of the listed

fields. 

The Plan Trip Menu provides opportunities to state personal preferences through

sub menus. Manage Route gives access to dialogue windows that express route and

speed preferences. The Travel/Time planner lets you set an average time between

stops, while Budget Planner provides a table for establishing trip cost estimates. 

Using Calculate Route from the Plan Trip menu lets you choose the quickest,

shortest, or most scenic route taking your preferences into account. The results for a

trip from Webster, NY to Kennett Square, PA, can be seen in columns 2 and 3 in the

table below. 

Routes can be changed by adding stops or waypoints using the Route Waypoints

submenu of the Plan Trip menu. Inserting Watkins Glen as a way point changed the

original trip data to that seen in columns 4 and 5.

1 - Option 2 - hours 3 - miles 4 - hours 5 - miles 

Quickest 6.36 363 7.06 364

Shortest 8.22 316 8.22 316

Scenic 6.49 349 7.27 366

Once the route was shown, any part of the map could be further enlarged by using

the cursor (cross hairs) to put boundaries around a portion of the route or by using

zoom commands from the View Menu; or Tool Bar icons. Clicking anywhere on the map

will move that point to the center of the window. 

This is by no means an exhaustive list of the programs capabilities. I did not do any

printing or testing for GPS use. Nor did I try to store trip photos However I did notice

errors in some of the local roads. For example, Route 441 is shown ending at Route 350

when in fact it goes further east to Marion. 

I planned a 2004 trip out west via Portland, touring the Oregon and Washington

coasts and returning home via Seattle, and Yellowstone park using Microsoft Streets

and Trips, circa 2001. It appeared to have much better detail even to the point of

showing service and rest stops along interstate highways. It also allowed a route to be

set by selecting a pencil tool and moving the cursor along any selected roads. Clicking

any map edge or corner eliminated the need for a compass rose freeing more space for

the map itself. It was also possible to insert a variety of identifiers for possible stops
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along with descriptive tags. A newer Delorme product might include some of these

same features.
Given the age of the product, John wasn’t required to write a review but he felt he should set a good

example. Thanks, John.

Juice Your Broadband Speed
by Vinny La Bash

Sarasota Personal Computer Users Group, Inc., FL

P
eople prefer broadband internet connections because of the obvious speed

advantages over dial-up and satellite links. Then why is it that broadband never

seems to be fast enough? Are you getting the speed promised by your ISP?

Broadband can cost $100 a month or more, but does the provider really provide the

advertised speed? Is the connection reliable or does the modem need a reboot several

times a day? Fortunately, there are ways to achieve high, reliable throughput without

having to have an engineering degree. Here are some suggestions to get every bit per

second possible from your modem without any technical hiccups or interruptions in

service. 

Start with your computer and TV equipment. A common source of line noise can be

traced to improper grounding of anything that plugs into household electrical circuits.

This can seriously degrade performance of cable equipment. Every electrical device,

especially those in the same room as the cable modem, should be plugged into properly

grounded outlets. The best connections are with polarized plugs oriented in the correct

direction, and please don’t use any three prong to two prong adapters. Get up-to-date

gear. Electric outlet testers are cheap. Buy one and use it to test for excess voltage on

your cable wiring. Any problem could indicate a serious safety hazard. Engage a

licensed electrician to fix it. 

Almost anything manufactured today in the consumer electronics world is light

years ahead of its predecessors manufactured only two or three years ago. Cable mo-

dems are no exception, so if yours is more than three years old get a new one from your

provider. Most providers will make a free exchange, but some will require an extension

of your contract. You want to do this because the latest modems conform to the

DOCSIS 2.0 standard. This offers higher upload and download capabilities and sup-

ports other advanced broadband applications, including online gaming and peer-to-peer

computing.

Ask your ISP if they automatically update firmware for the modem. If they don’t,

have them supply the website address of your modem’s manufacturer so you can

download the most recent firmware. Check the website about twice a year for new

updates. 

Next, go to a test site such as PC Pitstop, and check your upload and download

speeds to see if they match the terms of your service contract. If they don’t, give your

ISP a call and have them reset the modem’s settings. While you’re at it, have them

check the signal-to-noise ratio. Too much noise can cause interference, and your modem

will then have to resend information cutting down on your throughput. 
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It’s possible that your cable wiring may contain too many splices or simply be too

long. That can be fixed by a visit from your ISP technician. Have the technician check

the line quality leading to your house. If the signal is good and you’re having problems,

the house wiring may be the culprit. The definitive answer for cable modems is to

create a split directly after the junction box and then run a new cable directly to your

modem. The other side of the split will take care of your television sets which aren’t

nearly as sensitive to line noise. 

After you’ve done everything from a hardware and firmware standpoint, and your

cable connection is as clean as possible, you’re ready to fine tune the system for best

performance. Vista users don’t have to do much of anything to optimize the operating

system since Vista does TCP stack tuning dynamically. Any internet performance

adjustments can be made through the browser. Firefox users may want to try Firetune

or Fasterfox. They are both free utilities and allow adjustment to cache memory,

capacity and other settings such as pipelining. 

If you do a lot of downloading, you can save time by installing a download manager

like Flashget. This widely used utility claims the highest number of users on the

internet. It uses MHT (Multi-server Hyper-threading Transportation) technique. It’s

very easy to use and comes with exceptional document management features. Best of

all, it’s free.

After all this work, it would be a tragedy if you didn’t keep in mind that sometimes

the simplest solutions are the best ones. Most cable modems and routers have reset

features. Many a mysterious internet ailment has been corrected simply by resetting

the equipment. Turn off the computer and the modem. Un-plug the modem for a few

minutes and then power everything back on. You may be pleasantly surprised.
This article has been obtained from APCUG with the author’s permission for publication by APCUG

member groups; all other uses require the permission of the author (vlabash (at) comcast.net). 

File Management – Part One
by Ron Hirsch

Contributing Editor, Boca Raton Computer Society, FL

W
hat exactly do I mean when I say file management? And, I can hear you saying

“Who needs to fool around with that stuff. I have too many real things to

concern myself with. My computer takes care of all those things anyway,

doesn’t it?” Well, the answer is yes and no. If you went into a restaurant to dine, would

you rather select your own choices from the menu, or just have the waiter bring you

what he feels like bringing? Very few of you will answer with the latter. But, most

people don’t bother to establish/customize their file preferences on the computer. It’s

easier to just take what the computer has been set to do. And, they don’t have to learn

anything (they think) if they just accept all the defaults.

Please note that I’m making the assumption that you know how to use a mouse, and

right or left click on things. And, when I say “scroll down” or drag, you know what to

do. If you haven’t reached this point yet, I think it’s time to take a very basic beginner’s

course before proceeding.
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The simplest way to understand the way your computer stores things is to consider

the following. Suppose you saw a line of text as follows -

USA\Florida\Boca Raton\123 Broadway\2nd floor\room 24\gray file

cabinet\top drawer\3rd folder\2nd document.

I’m sure that everyone would understand exactly where to look for the document

in question. The line above is actually a descriptive path to get you there. Well,

computer hard drives store things in a very similar way. A path to get to a document

in your computer might be: 

c:\My Documents\Letters\Personal\Aunt Emma’s Birthday.doc

This path states that the filename is “Aunt Emma’s Birthday.doc,” and it is in a

folder named “Personal.” That folder is a subfolder of “Letters,” which is a subfolder of

“My Documents,” which is a folder on the hard drive C. To define paths in computer

language a “\” is used to separate the various elements of the path. Note that this

information is not case sensitive. That is, upper or lower case makes no difference. Just

having learned this already puts you well on the road to understanding file manage-

ment.

File management includes things such as establishing certain folders which will be

the storage areas for your documents, and other files. You direct where files will be

stored in various of your programs by saving your files in folders you establish or

define. This makes things easier when you want to do backups also. Many programs

allow you to specify what those folders are. So, when you go to save a file, that folder

comes up as the default. A common cry from beginners is “I saved the file, but I don’t

know where it is.”

Within a folder you can have sub-folders. For example, if you had a folder c:\letters,

you could put in subfolders for business, personal, club, etc. This way, you have an

organized filing system. If you have a file drawer that you use for filing things, most

people will have separate folders or hangers for different categories. Throwing

everything in the same area make it much more difficult to find things, just as putting

all your different socks into the same drawer, unpaired, and mixed up, makes life

tougher also.

Most people are intimidated by their computers. Remember, it’s only a machine,

and you should be the boss, not the computer. The more you understand, the more in

control you will feel. But, that doesn’t just happen. Like all things in this world, you

must make it happen.

Reading these articles, and doing the practice can help you along the road to that

end. 

Once you become reasonably proficient in the subjects to be presented, you will be

prepared to move files around, copy them to a floppy or ZIP disk to back them up, or

delete them. The exercise below should help you in this area.

Please note that the protocols used here are applicable not only to PC’s, but also to

Mac’s. These protocols are very logical once you understand them. The term “Windows”

will be used throughout the article. This means that all versions of Windows, 95, 98,

ME, or Windows 2000 will follow the same procedures
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Exercise Number 1

1. Open up Notepad - if you don’t know where it is, click on the Start button on the

bottom left of your screen  Start>programs> Accessories. Double click on Notepad,

and the standard Windows text editor will open. Notepad is simply a small program

in which you can generate and edit text documents. It offers almost nothing in the

way of formatting, but is a bare bones text editor, as opposed to WordPerfect or

Word which are capable of elaborate activities.

2. Type “This is a test.” in the Notepad window.

3. Save the document by clicking on File>save. A window will open. At the top of the

window is an area with the notation “Save in.” It will probably show your C: drive.

If not, use the scroll arrow to select the c: drive. Once you have done this and

double-clicked on it, there should be a listing below of all the folders on the C: drive.

Scroll to the one named “My Documents,” and double click on it. (My Documents

folder is a standard folder that Windows installs.) The focus is now on that folder.

Next, go down to the bottom of that window and in the field at the bottom, select

“all files(*.*)” just to see what else is in that folder. There is a field with “File name”

alongside of it. In that field, type testfile.txt.  Then click on the save button. You

have now saved that file in the “My Documents” directory. Now, exit Notepad.

4. Open Windows Explorer. If you don’t know how to do this, it’s time you learned.

Click on Start>programs>explorer. Or, click on the Windows key and the “e” key on

your keyboard at the same time. Navigate around to display the list of folders on

the C: drive. If that’s not what showing, find C: on the left and double click on it.

This should bring up the list of all the folders on the C: drive. Find the My

Documents folder, and double click on it. There should be at least one file there, the

one we just saved called “testfile.txt”.

5. Before continuing, I suggest that you configure Explorer to show all file extensions.

This makes working with Explorer easier. At the top of the Explorer Window, click

on View>Options, and then uncheck the line which reads “Hide file extensions for

the types that are registered.”

This is the end of part 1 of Learning Basic Windows skills. Next month, the second

part of this will cover moving and copying files, along with setting up new folders. If

you find this material useful, you may want to download this article in PDF format,

from our web site www.brcs.org. This allows readers to keep the material either as a

PDF file, and/or print it out, and place it in a looseleaf notebook for future reference.
This article has been obtained from APCUG with the author’s permission for publication by APCUG

member groups; all other uses require the permission of the author (ronhirsch1439 (at) comcast.com).

Geekonomics:

The Real Cost of Insecure Software
by Robert Palmer, NOCCC

T
he target audience for this book is people who are interested in the issue of who

should really be responsible for making sure that the software you use in your

computer is safe from serious errors and bad design. 
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Anybody who has ever bought software is familiar with the terms and conditions

that the vendor takes no responsibility for the software, and takes no blame for any

failure the software may have or may cause. Any defects in the software are your

problem. 

The author takes a fairly rigorous approach in his discussion. The title is

“Geekonomics.” This should have clued me in that his primary arguments are based

on economic grounds. Mr. Rice contends that the manufacturers of the software should

be responsible for sloppy software design, rather than making the customer responsible

for mitigating the problems caused by badly designed software. His point is well taken.

It is better and cheaper to solve a problem at the source, rather than trying to do

damage control after it has gotten out into the market. 

The book gives several examples of the consequences of shoddy software design. In

some cases, lives were lost as a result of poor design. So far, so good. The examples are

interesting and point up a need for reform. Almost all of his arguments for reform are

made by use of analogy. But, the analogies are relentless and become somewhat

tiresome over the course of the book. It reminded me somewhat of the way I felt when

I read my college textbooks (I just used another analogy! Help!) 

I looked at the author's biography, and, sure enough, in addition to being an expert

on computer security, he is an educator at the university level. 

Don't get me wrong. I respect the publisher, and I have several others of their books

in my library. Mr. Rice makes his case, and I agree with him on the issues. It was just

a bit tedious in places. People who write bad software should be responsible for it. We

shouldn't need to buy third-party software to protect us from poor design. The analogy

about automobile manufacturers being similar to software designers in responsibility

for their products resonates well with me. 

One argument he could have made, but didn't, is that vendors who don't guarantee

their software should not be allowed to prevent reverse engineering by the user, so that

the user can defend himself from any flaws he may find. Fair is fair. On the other

hand, vendors are faced with malware (software meant to break their product) and that

is sometimes difficult to anticipate. Software should be warranted against poor design,

but how and where do you draw the line against software that gets cracked? The book

ends with suggested incentives for vendors to improve their products. Buyers of the

book get a code that gives access to a linked website for 45 days. 

Authored by David Rice. Published by Addison Wesley Pearson Education. ISBN

number 0-321-47789-8. Copyright 2008. 

List Price $29.99.

For more information, check these web sites:

http://www.geekonomicsbook.com/ 

http://www.informit.com/store/product.aspx?i sbn=03 21477898 
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Ron Broadhurst

Broadsides
by Ron Broadhurst

Space Coast PC Users Group, FL

Dear Friends,

T
hese ideas are compiled from years of accumulations from various magazines,

books, on-line sites, and my own personal experience. I claim neither originality

nor ownership to any of its contents. My only intent is to share the various “tips,”

tricks,” and “hints” in hopes of helping and maybe enhancing your computing

experiences. They are all intended for anyone who uses a PC. It is for beginners as well

as advanced users. Enjoy and use as you will.

How to Have Windows Remind You About Pending Updates

C Click Remind Me Later in the Automatic Updates dialog box before you

download or install the update.

C In the Reminder dialog box, you can specify the

amount of time wait before reminding you.

C If the reminder is for downloading, Windows reminds

you only when you are connected to the Internet.

C If the reminder is for installing, Windows reminds

you according to the schedule that you specify.

And How to Download Available Updates

If you configured automatic updating to notify you before

downloading any updates, an icon is displayed in the notification area each time new

updates are found.

C Double-click the icon in the notification area.

C Do either of the following steps:

If you want Windows to download an update, make sure that the check box beside

it is selected. -or-

If you do not want Windows to download an update, click to clear the check box

beside it. Your selected updates are downloaded in the background; this behavior

allows you to continue working uninterrupted. Downloading does not interfere with or

slow down other network activity, such as Internet browsing.

When downloading is finished, the icon is displayed in the notification area to notify

you that updates are ready to be installed.

Customize The Start Menu

The Start menu gets more real estate in XP than in previous versions, and it’s more

customizable. To make the Start menu display only the applications you want, rather

than the default determined by Microsoft:

C Right-click in an empty section of the Start menu’s left column.

C Select Properties > Start Menu > Customize. Here you’ll find a list of your most

frequently used programs. (XP keeps track of what you use and what you don’t,

then updates this list dynamically).

Don’t want your boss to know that Pinball, Solitaire and Quake all make your list?

Go to the General tab, click Clear List, and set the counter to zero.
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How to Perform Disk Error Checking in Windows XP

This describes how to check the integrity of the hard disk drive in Windows XP.

After you install Windows XP, the Scandisk command is not available.

C Double-click My Computer and then right-click the hard disk drive that you

want to check.

C Click Properties and then click Tools.

C Under Error-checking click Check Now.

C Click Start.

Add Familiar Icons Back to Your Desktop

It’s the case of the missing icons. Many of you may be wondering where all the icons

from your desktop are in Windows XP? You can place at least My Computer, My 

Network Places and My Documents on the desktop.

Right-click on the desktop and then click Properties.

Click the Desktop tab and then click on Customize Desktop.

Put a check mark in the box next to My Document, My Computer, My Network

Places or Internet Explorer, to add those familiar icons to your desktop.

How to Find Your IP Address in Windows XP

Start and click Run

Type “cmd” (without quotes) and hit enter

Once the box opens type “ipconfig /all” (without quotes) and hit enter.
This article has been obtained from APCUG with the author’s permission for publication by APCUG

member groups; all other uses require the permission of the author (shiron (at) cfl.rr.com).

How to Clean the Hardware on the

 Inside of Your Computer
by Tina Gasperson

D
ust is the enemy of computer components - but ironically, computer components

seem to attract an inordinate amount of dust, which traps heat and clogs up the

fans that work to keep your system at the right temperature. If your computer

gets too hot, it will shut down to protect itself, but it could still be damaged by

excessive heat. It’s a good idea to open up your computer from time to time and clean

out dust and detritus.

The most useful tool for cleaning out the inside of your computer is a can of

compressed air. This is available at most computer supply and office supply stores.

Once you have your compressed air, shut the computer down and unplug it. You may

want to take the computer outside for cleaning so you don’t spread the dust around

your work area.

Look at the operating manual for your computer to find out how to remove the

cover. Most covers have tiny screws you’ll need to take out and set aside in a safe place

before sliding the cover off. Place the tiny straw that came with your compressed air

into the dispenser at the top of the can. Use this straw to direct the compressed air into

small places inside your computer - especially between items and inside fans, and in
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the power supply which is attached at the back of your system where you plug the

power cord in. You may be surprised by the amount of dust that flies out of your

computer.

Be sure to direct the air flow back behind all the elements in your computer, but be

careful not to dislodge anything. Keep an eye on what you’re doing just in case

something does get unplugged so you can plug it right back in. Tip the computer over

and give it a few taps to knock out any recalcitrant sticky bits of dirt and dust. And

finally, plug in a hair dryer, turn it to the “cool” setting and give the inside of your

computer a final once-over before you close it up. Don’t use the heated air setting or

you could damage your computer. Replace the cover, bring the computer back inside,

plug it in and boot up.
Tina Gasperson (tinahdee@gmail.com), affectionately known as Computer Lady by her family, has

been writing about IT, home computing, and the Internet for more than a decade. This article was first

published at Tiplet.com, a web site offering expert tips and tech support for Windows, Mac, and

Linux—visit to subscribe to their free newsletter

Tech News That Affects Everybody
by Sandy Berger

CompuKISS

S
ome of us scour the technology and business sections of the newspaper and the

Web to get the latest news. Some of us head for the lifestyle and community

sections, without much of a care about technology. Yet, today’s technology news

is often news that will affect everyone’s life in one way or another. 

Let me give you a few examples. The Pope recently announced opening of the

Vatican YouTube channel (www.youtube.com/vaticanit) which will feature short video

clips of Pope Benedict XVI’s activities and links to news and information about the

Catholic Church. The Pope is posting two or three videos each day. Most are short clips

showing the Pope’s speeches, activities, and participation in important events. In a

recent speech, the Pope praised the Internet as offering rich opportunities for dialogue,

friendship and spreading the Christian message.

There is a lot of irreverent stuff on YouTube, but the Pope’s participation shows how

mainstream this popular video website has become. YouTube, FaceBook, MySpace, and

other social networking websites have become more and more popular. If you haven’t

yet visited any of these, YouTube is a great place to start. (www.youtube .com)

Another recent news announcement was the Palm Pre, which is a smartphone that

will be available in a few months through Sprint. You might think that this is just

another phone, and you would be right. But the implications for cell phones are quite

dramatic. Palm has developed a totally new version of the operating system for this

phone. Google now has their own cell phone operating system as do Microsoft,

BlackBerry, and Apple. These are some pretty big name and you will notice that the

software that runs these phones is called an operating system. That’s because these

phone are really mini-computers that can do email, surf the web, and perform many

other functions. Cell phones are changing dramatically. They are turning into

handheld computers that will change the lives of those who use them.
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 We also should not overlook Apple’s recent announcement that they will be

dropping the DRM (digital rights management) for all songs in their iTunes store. The

DRM crippled the songs so they had limited use. For instance, they could only be

played on a certain number of devices or be copied a certain number of times. So music

lovers the world over will be rejoicing to see that by April of this year, all of iTunes 10

million songs will be DRM-free. There is one caveat. Those who have previously

purchased music and/or videos on iTunes that included Apple’s DRM will now have to

pay to get the DRM removed. Apple will be charging 30 cents a song. iTunes has sold

six billion songs since going online in 2003. They did not offer any DRM-free music

until recently. So most of those six billion songs had DRM. If every purchaser pays

Apple 30 cents for taking away the DRM, Apple would make $180,000,000. A boon to

Apple, a pain-in-the-rear for honest music lovers who previously used the iTunes store.

Last but not least in the technology news is the announcement that Western Digital

has created a 2 terabyte hard disk drive. Believe it or not, this may have one of the

biggest effects on individual users. As we can store more and more digital data at

reasonable prices, more and more data will be digitized. We are already living in a

digital world, but that world gets more reliant on technology every day.
This article has been obtained from APCUG with the author’s permission for publication by APCUG

member groups; all other uses require the permission of the author (sandy(at)compukiss.com). 

Improving Vista Performance
by Vinny La Bash

Sarasota Personal Computer Users Group Inc., FL.

M
icrosoft has added security features in Vista which didn’t exist in XP. There

are new functions and while the graphics are really neat, they can give your

system a big performance hit if you don’t have enough memory. Thanks to up-

to-the-minute technology, and great manufacturing improvements, RAM is cheap.

There is no good excuse for not loading up with as much memory as possible. 

Vista is the most RAM hungry modern operating system in existence. One gig is

about the lowest amount of memory you can have without feeling that you’re slogging

through a lake of molasses. Two gigs should give you acceptable response time, and

four gigs will put wings on your PC with some afterburner boost thrown in. Don’t be

a cheapskate. It’s false economy to starve your system of RAM. 

If you are already loaded with Ram, you can use Vista’s built-in ReadyBoost feature

in conjunction with a flash memory card or USB key to give an added kick to system

memory. You need a high performance flash card or USB drive. Insert the device and

Vista will politely ask you if you wish to use the device to speed up system perfor-

mance. Answer yes, and then tell Vista exactly how much of the device to devote to

speeding up the system. ReadyBoost will be active as long as the device is plugged into

the system. 

Once you have enough memory, examine your video card. If you want to experience

the full graphic capabilities that Vista offers, buy a video card that’s Vista Premium

Certified. 
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To see how your video card checks out, open up Control Panel, switch to Classic

View, and then activate the Performance Information and Tools utility. Look at your

base score. This number represents the overall graphic capability of your system.

Notice that your base score is not some combination of all the subscores. Your base

score is the lowest performing member of all your subscores. That doesn’t seem fair,

but that’s reality. You can try updating your score, but it probably won’t change. 

If you get between 1 and 3, general operations which include word processing and

spreadsheet tasks will work fine. Email and web browsing should be OK, but web sites

with large amounts of embedded graphics will take a long time to load. Video

applications will be problematical. 

A base score between 3 and 4 can run Aero and the majority of the new Vista

features, but Vista’s more advanced capabilities may bog down your system. For

example, your monitor will be satisfactory even at its highest resolution, but multiple

monitors may slow down your system severely. You will be able to watch most TV

shows, but a high definition broadcast could be a slow motion disaster. 

A base score higher than 4 should handle anything that Vista throws at it,

including HDTV and 3D gaming. If what you want or need from Vista requires a

higher base score than your system can provide, you need to replace one or more of

your components. Use the subscores to determine what stays or goes. A low score may

require you to either turn off the Aero interface or upgrade your video card. 

Go back to the Control Panel. From the Classic View activate the System icon and

then select Advanced system settings. When the System Properties dialog box comes

up, click the Settings button in the Performance section. You’re about to make some

tough choices.

If you can’t make decisions, you can Let Windows choose the best settings for my

computer and be done with it. Adjust for best performance disables all the great visual

effects that make Vista a terrific graphical interface. Adjust for best appearance makes

your system look spiffy, but you’ll take a hit on speed. 

Choosing Custom allows you to make some reasonable compromises while keeping

full control of your PC. Some features like sliding menus are pure eye candy and do

nothing useful. Turning them off gives performance improvement with no loss of

function. 

There are options in the Advanced tab where you can control how the CPU

processes work. What’s more important to you, adjusting for visible performance or

making sure that the housekeeping services Vista performs are performed efficiently?

Make your choice and monitor your system. You can always change it back later. 

Unless you know what you are doing, leave the Virtual memory section alone.

Virtual memory is a portion of a disk drive that’s configured to masquerade as memory.

Because it’s part of a disk and not physical memory, it can’t work as fast as real

memory. When the system runs out of physical RAM it can use a disk drive to keep

going instead of stopping dead in its tracks. 

You can change the location of the file to a different disk, resize it, or do both. Each

choice has consequences of its own. Making the wrong choice won’t destroy your

system, but it could noticeably slow down performance. The default choice is to let
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Vista manage the file. That’s the best choice for most people. 

There are many other things that you can do to get the best possible performance

from Vista such as modifying the Index Options, but that’s a subject for another article.
This article has been obtained from APCUG with the author’s permission for publication by APCUG

member groups; all other uses require the permission of the author (vlabash (at) comcast.net).

Tech News Tidbits
by Terry Robert

Program Chair, ICON (Interactive Computer Owner’s Network), MO

M
y intention in writing this article is to help us understand technology’s

emerging trends that affect our everyday lives.  While researching material for

this month’s submission, I felt compelled to share these alarming trends with

the rest of you.  

Sophos, a leading U.K.-based IT security and control firm, just published their

“Security Threat Report 2009,” which examined the “threat landscape” over the last

12 months, and predicted the emerging cybercrime trends for 2009.  Two major points

in the report are very alarming: 

• American computers are making a disturbingly large contribution to the problems

of viruses and spam affecting all of us today.”

• American websites host more malware and relay more spam than any other country

Graham Cluley, senior technology consultant for Sophos, said “Too many American

computers have been compromised and are under the control of hackers, and

nationally, the U.S. is carrying the most malicious Web pages. When an American

Internet company, accused of collaborating with spammers and hackers, was

disconnected from the net in November, the amount of spam was immediately reduced

by 75%.

Sophos’s research reveals that in 2008, organized criminal gangs tripled their

attacks against innocent websites, injecting malicious code to infect visiting home

users and businesses.  They also documented an average of five new scareware

websites (hackers posing as legitimate anti-virus vendors) each day, with the intention

of scaring users into believing that their computers have been compromised.

By the end of 2008, Sophos was also tracking five times more malicious attacks

arriving through e-mail attachments than at the start of the year, proving that hacking

has become mainstream among organized crime.

As the Internet has matured into the foremost information resource on the planet,

cyber criminals have refined their methods.  Hackers are using automated systems to

break into vulnerable websites and/or generate new variants of their malware

throughout the world!

According to Sophos’s findings, China was responsible for hosting more than 50

percent of all web-based malware in 2007, but this position was taken over by the U.S.

in 2008. Their breakdown of the top malware hosting countries follows:

1. U.S. 37.0 percent

2. China (including Hong Kong) 27.7 percent
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3. Russia 9.1 percent

4. the rest of the connected world 26.2%

Symantec also found the U.S. to host the most malware of all nations, but with

lower percentages, and did not include Russia in their results.

We haven’t devoted a lot of time to security issues recently, but if you’ve partici-

pated in some of the discussions we have had, you know there are numerous effective

strategies for protecting yourself from attacks.  

Avoid being connected to the Internet unless protected by:

C Dependable antivirus software (with current updates)

C Products include Avast, AVG, Norton, Avira, and McAfee

C Malware detection and removal software

C Products include Spybot Search and Destroy, Adaware, Spyware Blaster, and

Advanced WindowsCare

C Software firewall

C Products include Windows Firewall (protects only against incoming threats in

XP), Zone Alarm, and Kerio

C A healthy dose of common sense

C If you receive a popup telling you that your computer has been compromised,

advising you to: “Click here to correct the problem.” Don’t Take the Bait!Don’t Take the Bait!Don’t Take the Bait!Don’t Take the Bait!

If you have no strategy, do yourself (and the rest of us) a favor, learn to protect

yourself.  Maybe you should attend more society functions?
This article has been obtained from APCUG with the author’s permission for publication by APCUG

member groups; all other uses require the permission of the author (terry (at) iconusersgroup.org).

Media Notes
by Bill Petitt

South East Virginia Computer Group

H
ave you ever been watching a video in Windows Media Player and the computer

thinks its idle and turns on the screen saver? Here’s how to fix that:

1. With WMP open, right click the toolbar to bring up the menu

2. Click Tools | Options

3. In the Player tab, uncheck the box that says “Allow screensaver during

playback.”

Did you know this? Stop Wasting Ink
When you print out a Web page, you can use a lot of ink printing all those full color

images. But sometimes you only need the text and not the glorious Technicolor page.

The same goes when printing a page from an ebook. (Unless the printing function

is disabled by the ebook publisher).

Here’s how to save precious ink ...

1. Open Internet Explorer

2. Left click Tools and a drop down menu appears.

3. Click on ‘Internet Options’ and a box pops up.

3. Click the ‘Advanced’ tab
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4. Scroll down to the ‘Printing’ option and UNCHECK the ‘Print

Background Colors and Images’ box.

5. Click OK

Adobe warns of critical, unpatched security flaw
Attackers are making the rounds and exploiting a critical security flaw in Adobe

Reader 9 and Acrobat 9.

Earlier versions of the PDF-related software are also affected by the critical security

flaw, which could cause the applications to crash and potentially let an attacker gain

control of a person’s computer, Adobe Systems warned Feb 19th.

Reports also surfaced that attackers have developed an exploit and are taking

advantage of the flaw, the company said.

Adobe has yet to develop an update to address the vulnerability but noted it expects

to have one ready for Adobe Reader 9 and Acrobat 9 by March 11. After that, the

company expects to launch updates for the earlier versions of the software going back

to Adobe Reader 7 and Acrobat 7.

Doesn’t that make you feel warm, fuzzy and well loved?

Until then, Adobe advises, people should update their virus definitions and exercise

caution when opening documents from unknown sources.

Security company McAfee noted in a blog that the current attacks appear to be

targeted ones but that it expects new variants of the exploit to make the rounds as

more information becomes public.

In its posting, McAfee said that malicious PDF documents began to surface at the

start of the year, exploiting a vulnerability in Adobe Reader versions 8 and 9. The

attackers can then take advantage of a bug in Reader to overwrite memory at gain

control of executing code. After that, attackers can install a Trojan horse and from

there add a proverbial backdoor to a person’s computer to remotely control and monitor

the infected system.

Fly Cheap and Enjoy Finding Rock-Bottom Airfares 
Travel planning flies on the powerful Tripeedo meta travel site

Travel planning has to start somewhere. The best place I’ve found to start is on a

newish site called Tripeedo. It’s a search engine for airplane tickets that launched in

August.

Before your eyes glaze over, let me tell you why it’s a refreshing and powerful site

to use.

According to the site’s blog, the company launched a few new features recently that

I found really powerful and cool.

First and foremost, it’s not your average meta travel site. It now lets you search all

the major meta travel sites, plus all the major airlines in a single search. Just click

everything you want to search or, if you’re lazy like me, click “all.”

Rather than giving you a page full of results, it actually opens a new tab for every

hit, which happens to be the actual page. For example, the American Airlines page

actually opens, rather than a Tripeedo link to that site. Although this is, in my opinion,

the preferable way to do this, it doesn’t always give you instant gratification. For
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example, the pages you land on may ask for more information, or give you an error

message if it doesn’t like your criteria. Still, it’s much faster than any other method

that I’m aware of.

The thing I like best about it is that as you type in your search criteria, the site

automatically plugs in the full statement below. So you see what it understands before

it goes fetching airfares. You don’t need to know airport codes (for example, “LAX” or

“JFK”). If you type in the city, it automatically fills in the full name of the city plus the

relevant airport code. If you type in the code, it does the same thing. You’ll have to try

it to see why this is so gratifying.

The site also added a bunch more airfare providers, which is great to finding the

lowest possible fares.

In addition to great search, the site saves searches, and offers desktop gadgets, web

widgets and support for iGoogle, which is Google’s launch page site.

If you’re a traveling cheapskate, you have to check out Tripeedo. In addition to

being extraordinarily powerful, it’s the only airfare site I’m aware of that’s actually fun

to use.

Microsoft Readies Vista Update
Microsoft has released an almost final version of Vista Service Pack 2 to its testing

community.

The release candidate of Vista SP2 is not yet publicly available, but judging by past

releases you may not have to wait too long before the official update ships.

The timeline so far:

Microsoft released Vista SP2 Beta to its testing community in late October, and

made SP2 beta publically available in early December. Then the update seemed to

suffer some setbacks when, in late January, reports surfaced that Microsoft wouldn’t

be coming out with a release candidate of the update until March. A week later,

however, Redmond surprised the tech world by releasing it to a select group of testers.

Now Microsoft’s significantly larger testing pool reportedly has the near-final version

of SP2. Judging by the timeline from SP2 beta, a final version could be ready to go

within in the next 4 to 6 weeks; however, the Malaysian blog TechARP, which has been

right about Microsoft timetables before, believes Vista SP2 will start shipping around

>April or May of this year.

New Features
Vista SP2 is largely about improving performance, and in addition to the contents

of Vista SP1, the new update includes 691 hotfixes, significant performance

improvements and a Service Pack clean up tool that will recover some hard disk space

used by previous Vista updates.

However, Microsoft has included a few goodies that you’ll notice once SP2 is ready

to go:

C Windows Search 4.0 with faster searching and more relevant results

C The ability to record onto Blu-Ray Media through Vista instead of a third-party

application 

C Bluetooth 2.1 Feature pack to support emerging Bluetooth technology
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C Bluetooth 2.1 Feature pack to support emerging Bluetooth technology Simplified

Wi-Fi configuration tool

C Improved file synchronization across time zones

C Support for new 64-bit CPUs from VIA technologies

C Improved performance for Wi-Fi connections after your computer comes out of

sleep mode

C Improvements to DirectX multimedia with an improved graphics experience for

gamers

C Better streaming capabilities for high-def audio and video

C Improved content protection for TV programs recorded with Windows Media

Center 

In addition to Vista SP2, Microsoft is also testing the release candidate for Windows

Server 2008 SP2.

Talk about adding insult to injury:
Microsoft says it made an accounting error when it laid off some employees last

month and now feels the best way to correct the error is with what will likely add up

to a public relations blunder.

The software giant, which recently laid off some 1,400 workers, sent letters this

week to some of those former workers letting them know that their severance payouts

were a bit too “generous” and respectfully requested that the former employees pay

back that money, according to a report Saturday on TechCrunch.

An inadvertent administrative error occurred that resulted in an overpayment in

severance pay by Microsoft,” the letter states. “We ask that you repay the overpayment

and sincerely apologize for any inconvenience to you.”

A Microsoft spokesperson confirmed the authenticity of the letter posted by

TechCrunch but declined further comment, saying it was “a private matter between

the company and the affected people.”

The company declined to specify how many of these letters were sent out, and it’s

unknown how much the overpayments total, but it did indicate that some laid-off

employees were also undercompensated.

The letter failed to provide an explanation for the accounting error but did manage

to add—with underlined emphasis—a veiled threat of monetary punishment if the

money wasn’t repaid, at least in the form of a tax impact.

Then, a couple of days later…

Microsoft backtracks on severance issue

Amid a wave of criticism, Microsoft is backtracking on a decision to require laid off

workers to pay back money that the software maker said was in excess of its planned

severance.

Over the weekend, Microsoft confirmed it had overpaid severance money to some

and underpaid others. At the time, the company did not say how much money was

involved, but sent the workers who were overpaid a letter saying they would be

required to pay back the money in excess of the severance they were due.

On Monday, Microsoft human resources chief Lisa Brummel said the company was
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reversing course.

“I thought it didn’t make sense for us to continue on the path we were on,” she told

CNET News. Twenty-five workers were overpaid and about 20 underpaid, Microsoft

said.

Brummel said she has spoken or left messages to most of those affected and  those

overpaid received, on average, about $4,000 or $5,000 in extra pay.

“I have called now 22 out of the 25 impacted employees, only because I haven’t had

time to get to the three but I will after we hang up,” Brummel said.

In general, Brummel said it makes sense for companies to recover money if it makes

an accounting error, but she acknowledged the situation was an extraordinary one.

Brummel said the company actually overpaid her at one point during her long tenure.

“It actually happened to me and I wrote the company a check,” she said. “It may

have happened to others.”

Later on Monday Microsoft issued the following statement about the matter:

Last week, 25 former Microsoft employees were informed that they were overpaid

as a part of their severance payments from the company. This was a mistake on our

part. We should have handled this situation in a more thoughtful manner. We are

reaching out to those impacted to relay that we will not seek any payment from those

individuals.

Microsoft also said that the company is immediately reimbursing the underpaid

employees.

I suppose this is what happens when you let mechanical policies be followed without

human oversight. That is, until you get bad press!

Well, that’s it for this month. I’m running late getting this to our editor so until next

time…
From the March 2008 issue of  The Umbrella Online, the monthly newsletter of the Hampton Roads

Virginia computing community.

Use AutoCorrect to Automate Word
QQQQ. Every time I open a program on my XP computer, it is listed in the lower left-hand

section of the Start Menu. How can I keep that from happening? It’s easy to delete, but

I would rather it didn’t appear in the first place.

A. As is frequently the case, one person’s feature is another person’s annoyance. What

you describe is considered a feature of Windows XP that makes it easy for you to return

to recently used programs. You can, however, disable it by right-clicking a blank spot

on your Taskbar, then selecting Properties. In the “Taskbar and Start Menu

Properties” window, click the Start Menu tab > Customize... button > General tab. 

Near the center you will see the Programs section and a box in which you can adjust
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the number of programs that appear on the Start Menu. Click the down arrow until the

number is zero to prevent any programs from being displayed. Click OK > OK to save

your changes and exit. 

QQQQ. First, I would like to thank you for writing your weekly newsletter. It’s excellent

and I never fail to learn something every week. Okay, now to business: Is it possible

to have Microsoft Word automatically capitalize the first letter that appears after a colon?

A. Word does not have the ability to do that on its own, but with a little fancy

keyboarding, you can create a work-around to perform that task. What you need to do

is set up an AutoCorrect entry to replace any occurrence of a colon, with a colon-period

combination.

Then, as you are typing, when you type a colon followed by a space, Word will

automatically change it to a colon followed by a period and a space. Word’s AutoCorrect

feature, thinking that the next letter, after the space, is the first letter of a sentence,

will capitalize it. When you have completed your document, perform one quick Find

and Replace (CTRL + F) to change the colon-period combo back to a colon.

While I’m all for automation, sometimes it’s just as easy to do things the old-

fashioned way, so I’d tend to manually capitalize a word, unless it was something that

came up frequently. I figure if it was good enough for my old Smith Corona, it’s good

enough for my high-falooting computing.

QQQQ. When I try to create a Desktop shortcut to a Web site, it says one already exists, but

I can’t see it. Do you have any suggestions, Mr. M?

A. You can view a list of all the items on your Desktop by clicking Start > Run, type

“desktop” (without the quotes) and click OK. As an alternative, right-click a blank area

of the Desktop and select Arrange Icons By > Auto Arrange. All icons will snap to a

pre-configured grid pattern, revealing any icons that might have slithered out of view.

If you’re using Windows Vista, right-click a blank area of the Desktop and select View

to get to your Auto Arrange options. Regardless of the method deployed, you will then

be able to see any existing shortcuts.

Mr. Modem’s DME (Don’t Miss ‘Em) Sites of the Month

Guess the Show Name
This is a goofy-yet-quasi-entertaining site in which your task is to think of the name

of a TV show or movie, then answer a series of “Yes” or “No” questions. The ultimate

objective is for the site to guess the name of the show or movie that you have in mind.

www.guessthename.com

How Stuff Works
Have you ever wondered if flour can explode, or how a car’s differential works, or

what makes your refrigerator cold? Me neither, but this is a fun site that’s chock full

of information. Did you ever wonder what the derivation of “chock full” is? Theories

abound, though one popular theory suggests that “chock” relates to the word “choke”

and that the phrase derives from “choke full,” or “full to the point of choking.” (Who

would have thought this column would be educational, too?) 

www.howstuffworks.com
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Recipe Converter
If you have a favorite recipe that serves six or eight people, and you want to scale

it up or down to serve one or two or ten or 20, the Recipe Converter will get the job

done. Simply fill out the online form by entering your conversion factor, such as .5 to

cut a recipe in half, or 1.5 to multiply it by one-and-a-half, and the ingredients. After

revamping your recipe, if you want to save the results, either print the page or click

File > Save As to save it to your hard drive or other location. 

http://tinyurl.com/e3jwk

For plain-English answers to your questions by email, plus great computing tips,

subscribe to Mr. Modem’s award-winning newsletter. Subscribe using Promo Code

1640 and receive two free months with your 12-month subscription (60 issues!) To view

a sample issue or subscribe, visit www.MrModem.com.

Mr Modem had a personal relationship with Paul Harvey. You cam find his tribute

to Mr. Harvey at http://tinyurl.com/afrb3w.

From the DealsGuy
by Bob (The Cheapskate) Click

Greater Orlando Computer Users Group

Try This One On For Size

T
hree months ago, I purchased a digital picture frame, but when I hooked it to my

desktop machine via the USB cable, “My Computer” was unable to “see” the

picture frame’s memory, which had software on it to install for processing my

pictures automatically and sending them to the frame’s memory. I tried repeatedly and

it might finally see it briefly, but once you clicked somewhere else, then back, it was

gone. Windows Explorer didn’t work with this frame’s memory any better. I tried it on

my other desktop computer with the same results. Both of these computers have an

Intel Pentium-4 3.06 Gigahertz motherboard. I adjusted the pictures with another

software and put them on an SD flash card, inserted it in a memory slot on the picture

frame, and it would run the picture slide show fine when standing alone. As I said,

neither machine could see that frame’s memory, except for a brief glimpse occasionally.

I returned the picture frame for a refund thinking it was defective, and the store

manager agreed with me after I explained.

I bought another digital frame the other day, bigger and better. When I tried

hooking it up to my desktop with the USB cable, I got the same results all over again.

I was unable to “see” the digital picture frame’s memory with “My Computer” to install

the software that came with it. I finally decided to download the software in question

from their Web site and install it on my desktop. After that, I ran the software to

access the pictures from the My Pictures folder, process them, then send them to the

frame’s memory, but it gave me a message that it couldn’t find the memory. I couldn’t

find it with Windows Explorer either, except briefly on rare occasion, then it would

disappear, however, during that brief viewing, I did notice that there were actually

three pictures that got loaded before getting the error message.
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After several tries using different USB plugs on the computer, different USB cables

and always the same response, I gave up and tried it on my other desktop, with no

better luck. I have used many USB items on my desktop machines with no problems.

I decided there was a coincidence here and tried hooking it up to my laptop, which has

Vista on it. Both desktop machines use XP Professional. It works fine on my laptop and

I am at a loss to figure out what’s wrong on the two desktop machines that work good

otherwise. A knowledgeable friend worked with me on the phone one evening, with no

luck. I am out of ideas.

Tired Of Quicken or MS Money? Try This One
Alzex announced Personal Finances 3.2, the newest version of a personal finance

manager that will help users track income and expenses quickly and virtually

automatically. With a glance at its reports and graphs, users will understand their

earning and spending patterns, find areas of excessive expenditure and cut down

unnecessary expenses. Personal Finances also provides future planning. Users can

project expected spending and income, and know their exact financial situation at a

future date.

The budgeting task is a snap. Running the program will open a simple, uncluttered

interface that puts all the financial details, tools and options that matter most to you

up front. First the user needs to start budgeting by seting up accounts, categories, and

subcategories. Personal Finances allows for any number of accounts, so the user can

set up accounts for your bank, credit card, and cash. Next, set up categories and

subcategories. They will classify and sort income and expenses and help the user see

this important data in a meaningful and detailed way through reports and graphs.

Next for budgeting is to enter transactions that can reflect income and expenses.

Transactions can be one-time or scheduled, which makes Personal Finances handy for

regularly occurring expenses, such as tax payments, electricity bills, Internet, etc.

Transactions can be identified in a number of ways including categories, family

members, and tags. Tags provide a way to differentiate between similar transactions

that fall into the same category. Categorization by family members will show spending

habits of each member of the family in reports.

Personal Finances offers a summary view of all transactions, reports by categories,

family members and tags to see how much of the budget is allocated to each category

or family member, and identify areas to cut spending if the budget comes out on the

negative side. The user can generate reports that cover any period of time. Results can

be printed out, or saved to one of the formats: HTML, CHM, or TXT.

With Personal Finances, one can have the convenience of the personal finance

software without carrying around the laptop. When the user goes out of town, they can

install Personal Finances onto a USB flash drive and keep track of all purchases.

Simply plug the USB flash drive in to any computer, update transactions and unplug

it. No traces are left behind on the host machine.

New to version 3.2 are 50 icons for accounts and 200 icons for categories. Now the

user can see the summary for a month, confirmed and non-confirmed transactions, and

can group transactions by name.
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Personal Finances runs on Windows 98/NT/2000/XP/Vista and comes in two

editions: Professional and Freeware. For more information about the products, visit

<http://www.financessoftware.com>. You can download the 30-day trial version, an

absolutely “free” version or the paid version. For the paid version, user group members

are offered a 20% discount on the purchase of Personal Finances 3.2. The coupon code

is pf43M5G. They failed to respond when I asked when the discount will end, but right

now the discount code will still recalculate the price so I hope it’s still good when you

read this.

Also, be aware that the description I included above is for the paid version, so do

your homework if you want the free one and look at the comparison columns on their

Web site. Several features in the paid version aren’t in the free version. Also, I’m not

sure if it tracks securities, which MS Money and Quicken will do.
That’s it for this month. I’ll have some more new product announcements on my Web site that didn’t

offer discounts. Meet me here again next month if your editor permits. This column is written to make

user group members aware of special offers or freebies I have found or arranged, and my comments

should not be interpreted to encourage, or discourage, the purchase of any products, no matter how

enthused I might sound. Bob (The Cheapskate) Click <bobclick at bellsouth dot net>. Visit my Web site

at <http://www.dealsguy.com>.

Society News

March Planning Meeting
by Sharah Blankenship, Secretary

S
teve Staub led the Planning meeting held at Sally Springett’s house, March 3rd.

Others in attendance were Bob Avery, Tony Dellelo, Mike Lavelle, Sharah

Blankenship, Sally Springett, and Dan Rothfuss. 

The February meeting was discussed, and it was decided that the Extended Helps

Half Hour went well. A good turnout was seen for the night, and many people

expressed that their questions were answered satisfactorily.  

The April meeting will NOT take place at the Brighton Library; it will be at the

Gates Library, 1605 Buffalo Road, and begin at 6:30, as normal. Anyone who wishes

to is encouraged to bring goodies. The April meeting presentation will be given by

Sharah Blankenship on Social Networking and Blogging.

Mike Lavelle will be looking into presentations that are videos, or in-a-box , as

needed for this year. Ideas for future presentations, or persons wishing to present

should talk to him.

Welcome, to any new members. If you are an existing member, please be sure that

your dues are paid, as several members dues are overdue by more than three months.

Please see Steve if your membership is overdue.

For this year’s picnic meeting, the lodge has been reserved in the Brighton Town

Park, 777 Westfall Rd, Rochester, NY 14620. The Board would like to ask the members

to begin planning for the Silent Auction now. Please begin thinking about what you

could donate—we will put anything up for auction that you wish to donate. (Please

note that if your item does not sell, you will need to take it with you.) If anyone would

like to coordinate/run the Silent Auction, please see any Board member to sign up!
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Unless anyone is interested in running for a Board position, the current Board

members have agreed to retain their positions for the 2009-2010 year.

We look forward to seeing you all at the April meeting! 

Help’s Half Hour
Led by: Carl Schmidtmann

Recorded by Jan Rothfuss

QQQQ: Does anyone have any experience with Road Runner’s firewall?

A: No one had experience so the recommendation was to stay with AVG.

QQQQ: Is the new Ubuntu any different?

A: There are some new updates with another expected in April. Version 8.04 is still

under long term support (3 years). The others may only have updates for 18 months.

QQQQ: A member is having a problem with the time being 5 hours off. He can manually

change it but it goes back. He is using XP.

A: You can set the time zone and then ask to get the time off of the server. The process

could not be confirmed but will be added to the newsletter.

QQQQ: Another member deleted the browser history and now the address bar has

disappeared. It took a long time. Is there a way to keep this list shorter?

A: Using favorites will keep these even if history is removed.

QQQQ: A repeat question on how to copy vinyl records to a computer file.

A: Audacity is the best free tool. You will need to boost the volume by using a pre-

amplifier. 

QQQQ: Is there an easy way to get ride of pop ups?

A: You can set up a pop-up blocker. That should help. You may also need to check for

viruses as they can appear like this as well. Be sure that you have good backups.

Firefox also has a flash-blocker if you are using that browser. There can also be pop-

unders that will sit underneath your main window and appear when you shut them

down.

QQQQ: Every morning at 1-1:30 a.m., his computer goes crazy.

A: This is likely the caching preparing for future searches. Sometimes your antivirus

will kick in as well. Most machines check for updates overnight as well.

QQQQ: How safe is it to run a live CD distribution from a flash drive? How about virus

protection? He is using Linux.

A: It is fairly safe. Linux has very few viruses. 

The Lighter Side
Customer: “Have you ever heard about ‘Mozarella Firefox’?”

Tech Support: “Now, go back to your desktop.”

Customer: “I don’t have a desktop. I have a laptop.”

Customer: “So do I go to Word or Excel to start XP?”
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Customer: “I need help with my scanner. I put pictures in and close the scanner, and

nothing happens. It’s broke, and I want my money back.”

Tech Support: “I am looking at your sales, and you did not purchase a scanner from

us.”

Customer: “You are an idiot! You do not know what a scanner is!”

Tech Support: “Did you buy a scanner from somewhere else?”

Customer: “No. It came with the computer and opens on the front of the unit. Every

time I put in a picture and close the door, it does nothing, and when I open the door,

the picture is gone. Now the door will not close all the way.”

Tech Support: I extracted five pictures that were scrunched up in the back of the CD-

rom drive.

A friend of mine was recently doing his resume and listing his experience with

different operating systems. When the Word spelling/grammar checker came across

“Windows ME and Linux,” it was quick to suggest that "Windows, Linux, and I" would

be more appropriate. 

Customer: “My mouse doesn't work any more.”

Tech Support: “Is it an optical or ball mouse?”

Customer: “Huh?”

Tech Support: “Does it have a ball or light?”

Customer: “It has an light on top.”

Tech Support: “On top?”

Customer: “Yeah. It was underneath before, but it looks better when it's on top.”

Tech Support: “Ok, try turning it around so the light points down on the desk.”

Customer: “Oh! It works!”


